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Welcome to the Red Book: “How to Produce Accurate Color Reference Guide.” 
Following these guidelines will ensure that we provide our customers with the  
colors and quality they want. Using this guide will not only keep your equipment  
in good condition but also reduce the cost of mistints.

Contents

Colorant Dispenser General Maintenance Guidelines_______________________________________________3

Paint Department Daily Maintenance Checklist__________________________________________________________4

Paint Department Weekly/Monthly Maintenance Checklist________________________________________ 5

Hero Daily Recommended Maintenance__________________________________________________________6

Hero Dispenser Backup_ ________________________________________________________________ 7-8

Hero Extended Power Loss_ ______________________________________________________________ 9

Hero Preparing for a Natural Disaster_ ______________________________________________________ 10

Fluid Management® Daily Recommended Maintenance____________________________________________ 11

Corob® Daily Recommended Maintenance__________________________________________________________ 12

Corob® Dispenser Backup (CorobTECH)___________________________________________________13-15

Corob® Dispenser Restore (CorobTECH)___________________________________________________16-18

Corob® Dispenser Backup (EVOservice)__________________________________________________ 19-20

Corob® Dispenser Restore (EVOservice)__________________________________________________ 21-22

Working with Half Pints________________________________________________________________________23-24

Half Pint Accessories for Corob™ Dispensers and Shakers____________________________________________25

Half Pint Accessories for Fluid Management® Shakers_ ______________________________________________26

Half Pint Accessories for Radia® Shakers_ __________________________________________________________27

Half Pint Accessories for Hero Mixers_ _________________________________________________________ 28-30

X-Rite® MetaVue™ Recommended Maintenance________________________________________________________________31

X-Rite® iVue Daily Recommended Maintenance, Tips, and Supplies_______________________________________32-33

X-Rite® i1 Paint Daily Recommended Maintenance_____________________________________________________________ 34

BYK® Auto-Match® IV Recommended Monthly Maintenance__________________________________________________ 35

Datacolor® 45G Recommended Monthly Maintenance________________________________________________________ 36

Introduction to Color Matching__________________________________________________________________________37

Evaluating Dispenser Accuracy________________________________________________________________________  38

Gennex® Waterborne Color Technology_____________________________________________________________________ 39

Customer Support_________________________________________________________________________________________40

Introducing the Red Book



3

Following these maintenance guidelines will keep your dispenser working to its full potential. 
Consult the owner’s manual or additional pages in this guide for specific details.

Daily Maintenance

• Clean nozzles with appropriate tool.

• Open the nozzle cover, inspect, clean and moisten sponge.

• Empty and clean nozzle drip area.

• Purge colorant nozzles and visually inspect that colorant is dispensing properly.

• Refill humidification tank if applicable (use distilled water).

• �Add colorant as needed per equipment manufacturer’s or  
colorant manufacturer’s instructions.

• �Check and adjust colorant levels in software to match canister fill.

• �Shake colorants for 5 minutes before adding to the dispenser. 
Allow dispenser canisters to agitate after the addition of colorant.

• �Clean outside surfaces with a mild cleaning solution or damp cloth.

Weekly Maintenance

• �Visually inspect for obvious problems (e.g., mold, leaks, spills, drips).

• �Check that all canister motors are agitating.

• �Clean all spill trays.

• �Dispense one ounce of any colorant that has not been used in a week.  
Can be dumped back into canister.

Monthly Maintenance

• �Check and adjust colorant levels in software to match canister fill.

• �Replace sponge insert.

• �Grease automatic shelf and automatic nozzle closer  
as recommended by the manufacturer.

• �Check calibration as per manufacturer.

Colorant Dispenser General Maintenance Guidelines
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Spectrophotometer

Task Frequency SUN.
Completed by

MON.
Completed by

TUE.
Completed by

WED.
Completed by

THU.
Completed by

FRI.
Completed by

SAT.
Completed by

Spectrophotometer 
(CF57) cleaned  
and calibrated

Daily

Spectrophotometer
(MetaVue)  
calibrated

Daily

Dispenser

Task Frequency SUN.
Completed by

MON.
Completed by

TUE.
Completed by

WED.
Completed by

THU.
Completed by

FRI.
Completed by

SAT.
Completed by

Visually check  
colorant levels 

Daily  
a.m./p.m.

Add colorant  
if needed
(O1, etc.)

Daily a.m./p.m.  
or as required

Update  
colorant levels 

in COLORx® 
software

Every time  
colorant is 

added

Clean
nozzle tips Daily a.m.

Clean sponge  
and add water Daily a.m.

Purge
colorants Daily a.m.

Standardized checklists serve as a quick reference to maintenance steps. You may print 
the samples below or create your own.

•	Post sheets near the equipment or make available in a binder or on a clipboard.

•	Train staff to initial the appropriate box when a task is completed. 

•	Collect and review with staff. 

Paint Department Daily Maintenance Checklist
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Paint Department Weekly/Monthly Maintenance Checklist

Spectrophotometer

Task Frequency Completed by Completed by Completed by Completed by Completed by Completed by Completed by

Spectrophotometer 
(iVue) cleaned  
and calibrated

Weekly

Spectrophotometer
(MetaVue) cleaned Weekly

Dispenser

Task Frequency Completed by Completed by Completed by Completed by Completed by Completed by Completed by

Clean spill trays 
around the canisters Weekly

Visually inspect 
unit for any obvious 

problems
Weekly

Check all agitation 
motors are working Weekly

Dispense extra 
colorant of less 
frequently used 

colorants

Weekly

Clean all surfaces 
with soap and water Weekly

Compare and update 
colorant levels in  

software with what  
is in canisters

Monthly

Examine and replace 
sponge insert Monthly

Examine nozzle 
closer and maintain 

if needed via 
manufacturer’s 

recommendation

Monthly

Department manager: Collect and review each week.



6

Clean the Cup
•  �Wash cap in sink with  

warm water
•  �Clean sponge and  

replace inside cap

Close the Nozzle Cap
•  �Close nozzle cap until  

you hear a click
•  �Select Close nozzle cap
•  �Click Execute

Clean Nozzle Tips
•  �Dab nozzle ends with 

moistened paper towel
•  �Remove any dried or 

dripping colorant
•  �Do not push nozzles up

Replace Cap and 
Sponge Insert
• Moisten sponge with water
• Replace cup holder into
		 closing bracket, making
		 sure the cup, cup cap, and
		 moisture ring are sealed

Purge Colorant
•  �Select Maintenance>Dispenser>Commands
•  �If asked to purge, click Yes
•  �Select All Canisters
•  �Click Execute 

Open Nozzle Closer
•  �Select Open nozzle cap
•  �Click Execute

Remove Cup Holder from Nozzle Closer
For automatic caps:
• With the capper in the open position, lift the cup up to release it.

Open COLORx
For automatic machines 
using COLORx:
•  �Select Maintenance> 

Dispenser>Commands
•  If asked to purge, click No

77 8

Hero Daily Recommended Maintenance
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Remove Cup Holder from Nozzle Closer 
Automatic caps:

For automatic caps:

• With the capper in the open position lift the cup up to release it.

Open COLORx
For Automatic machines 
using COLORx
•  Select Maintenance>

Dispenser> Commands
• If asked to Purge click No

1

4

77 8

5 6

2

Hero Daily Recommended Maintenance

55 66
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1

4

77 8

5 6
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55 66

Daily Nozzle Cleaning Instructions:
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Hero Dispenser Backup

1

4

2 3

Log in to Tintwise as an admin by clicking
on Login on the left-hand side of the
main screen.

Choose Administrator from the dropdown menu
and type in the password “Producer”. Click OK and
the login window should go away.

In the new window that opens, you must fill in some details.

First you’ll want to change the output path to an external flash drive, which is  
done by clicking on the magnifying glass and locating your drive (where the  
backup file will be stored).

You’ll need to adjust the Output file name option. If it is already filled in, simply  
adjust the date and move on. A more real-life example of this format is as follows:  
SN XXX-XXXXX - Customer Name - Colorant Line -YYYYMM-DD

Leave the Description field as is.

From the Quick Selection drop down menu, choose Complete back-up; it will 
automatically select all possible options to be saved. Some options will remain
unchecked. If you do not have the option for “Complete Backup,” simply place  
a checkmark in all available boxes. Click Save on the bottom of the screen.

On the top left of the screen, click  
on File, then hover over Data. Now
click on Export Data and a new
window will open.
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Hero Dispenser Backup

Expect to see a window similar to the one shown. Text
will quickly scroll down the window while the backup
archives the files. At the end of this process, a window
should pop up that says “Successful.” If you have any
issues, please make sure there are no special characters
in the file name as it is best to use only letters and
spaces. If it still fails, please call HERO customer service
for advice at 800-494-4376.

Exit all screens until you return to the TintWise software main screen.  
Click on Logout and your backup is complete.

Remember to remove the flash drive and keep it in a safe place.

5
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Hero Extended Power Loss

Extended Power Loss or Disconnect

NOTE: The dispenser should be without power for as little time as possible. However, before powering it back on for the first time,  
please make sure it is safe to do so, especially in the case of water damage.

This document explains what steps should be taken to ensure that the dispenser is ready for use after an extended power loss or disconnect.

The following tasks should be performed by a staff member who is familiar with the dispenser and terminology that is being used.  
If no such staff member is present and you would prefer assistance over the phone, please call 1-800-494-4376 or email customercare@hero.ca.

After a Power Loss

Checklist

Please read this entire list before starting. If, at the end, you require assistance, please contact Hero.

1. Check that all colorants are healthy by looking for signs of separation, hardening, congealing, etc. Take note of any colorants that may  
be unhealthy. If any colorants look extremely unhealthy, exclude them from dispense tests. If they are very dry or hardened, call Hero  
before proceeding past this step as the agitation process could cause damage to some components.

2. Turn on dispenser and listen for agitation.

	 If agitation does not start, test the following:
	 • Check that the front-facing e-stop or toggle switch is turned on.

			   o E-stop: pulled out = on

			   o Toggle switch: “|” = on; “O” = off

			   o If it is on, turn off for 30 seconds, then back on again.

	 • Does the main power outlet work with another device such as a fan or lamp?

	 • Is the surge protector plugged in?

			   o Does the surge protector work with another device such as a fan or lamp?

			   o Does the surge protector need to be reset?

	 • Make sure the dispenser’s power cable is plugged firmly into the surge protector and the rear of the dispenser.

	 • If there is a power switch on the rear power cable receptacle of the dispenser, make sure it’s on. (“|” = on; “O” = off)

	 • Is the fuse in the rear receptacle still good?

3. Check that all canisters are agitating. Take note of any that do not agitate.

	 • After the agitation stops, check any unhealthy-looking colorants from step 1. If they still look unhealthy, repeat agitation once more.

	 • Take note of any colorants that still look unhealthy.

4. Clean nozzles and sponge: fill sponge cup with water.

5. Purge each colorant one at a time, excluding any that look unhealthy from step 3. Take note of any that do not purge correctly.

	 • Re-purge any colorants that failed the first purge. If they still do not purge correctly, try dispensing half an ounce from each failed colorant.  
		  Then purge again.

			   o If the pump makes no noise during purge or dispense, take note of that colorant and exclude it from the following tests:

	 • If any continue to fail the purge, you may remove the nozzle and clean it under running water.

	 • Test dispense another half ounce of each of the colorants whose nozzles required cleaning. Purge again.

	 • Take note of any colorants that still do not purge.

	 • If you had no failures during this process, then you can continue operation as normal. If any tests failed, please contact Hero for support.  
		  Call 1-800-494-4376, option 1, or email customercare@hero.ca.
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Hero Preparing for a Natural Disaster

Preparing for a Natural Disaster

The following are some basic steps to help prevent damage to your dispenser. As the Hero warranty does not cover  
“acts of nature,” it is of utmost importance that you prepare as soon as possible.

When the electrical grid fails and when it comes back on, power surges can occur that may harm electronic components.

Start by completing your daily maintenance procedure, ensuring that your sponge cup is completely full of water. Unplug 
any electronic devices that you do not wish to see damaged, such as the Hero Automatic Dispenser, computers, monitors, 
etc. You may also want to turn off relevant circuit breakers from the main breaker panel.  
Speak with your electrician for further details and recommendations.

You may wish to move the dispenser to a safer location such as a raised floor, or, if possible, carefully raise the dispenser 
off the ground to decrease the chance of flooding damaging the dispenser. This is important as many of the dispenser’s 
primary components are on the bottom of the unit. As it is impossible to know how high the water level will be if a flood 
occurs, it is up to you to use your best judgment.

Cover the dispenser and computer with a tarp to prevent water damage from sprinklers should they come on. Be sure to 
fasten the tarp in place.
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Daily Nozzle Cleaning Instructions:

Open COLORx®
For automatic machines 
using COLORx:
•  �Select Maintenance> 

Dispenser>Commands
•  �If asked to purge, click No

Open Nozzle Closer
•  �Select Open nozzle cap
•  �Click Execute

Replace Sponge
•  �Replace sponge insert
•  �Moisten sponge with water
•  �Replace cup holder  

to closer bracket

Clean Nozzle
•  �Clean each opening  

with included nozzle 
cleaning pick

•  �Use a circular motion to 
make sure opening is clear

Clean Cup
•  �Remove sponge insert
•  �Clean inside of cup liner 

with water and paper towel

Remove Cup Holder from Nozzle Closer
For semi-automatic caps:
•  �Unscrew wing nut on bottom of cap
For automatic caps: 
•  �Lift cap straight up, then over to the left
For manual AT1500: 
•  �Remove container and release lever to open position

Close Nozzle Closer 
For AT1500: 
•  �Remove container and release lever to closed position

Close Nozzle Closer 
For automatic machines:
•  �Select Maintenance> 

Dispenser>Commands
•  �Click Close nozzle cap
•  �Click Execute

1 1

6

8 8

3 4 5

22 2

8

Purge Colorant
•  �Select Maintenance>Dispenser>Commands
•  �If asked to purge, click Yes
•  �Select All Canisters
•  �Click Execute 

7 7

Fluid Management® Daily Recommended Maintenance
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Open Nozzle Closer D300 
(manual only)
•  �Add purge container and 

push lever to open position

Replace Sponge
•  �Replace sponge insert
•  �Moisten sponge with water
•  �Replace cup holder  

to closer bracket

Clean Cup
•  �Remove insert and sponge 

from nozzle closer
•  �Clean the sponge
•  �Clean inside of cup liner 

with water and paper towel

Verify Water Reservoir
•  Check that water reservoir  
    is filled between  
    minimum and maximum  
    settings
•  �Fill with distilled water  

if needed

Clean Nozzle
•  �Examine for dry 

colorant on tips
•  �Clean with a paper clip

Close Nozzle Closer (Corob)
For D300:
•  �Remove container and 

release lever to closed 
position

Remove Cup Holder from 
Nozzle Closer
•  �Grasp cup and twist 1/4 turn 

counterclockwise

Purge Colorants Through  
Corob Driver
•  �Open Corob® Driver
•  �Click Yes to proceed with 

dispenser initialization
•  �Place purge can under nozzle
•  �Click Yes to purge button
•  �Remove can after purging

1

5

4

8

3

7

2

6

Corob® Daily Recommended Maintenance

Daily Nozzle Cleaning Instructions:
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Corob® Dispenser Backup (CorobTECH)

Performing the Corob restore using CorobTECH software

Open CorobTECH.

Enter “tech” for the CorobTECH password.

Under the Options menu, select Backup/Restore.

1

2
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Corob® Dispenser Backup (CorobTECH)

In the Backup/Restore window, choose the default option under Select Backup Data.

Then select your destination folder (in our example below, we are saving to a flash drive).

Choose Start to initiate the backup.

When the backup is finished, you will receive a “Backup completed!” message.

3

4
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Corob® Dispenser Backup (CorobTECH)

Check that you can see the resultant backup file.

Performing Backups for Your Important Corob Dispenser Files

(Alternate method of obtaining needed files.)

In the event that you are unable to create the backup from the CorobTECH software, you will be able to retain the necessary 
information for your dispenser machine by obtaining a copy of the local directory from your original C: drive.

You will need to have this directory available if you are to move your dispenser to a different PC or in the event of a PC failure.

The information contained in the collection of files includes your calibration and level information for your Corob dispenser.

You will need to save two directories, local and GDATA, to protect your Corob dispenser data.

These directories are located at the root of your C: drive.

C:\local

C:\GDATA

5

6
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Corob® Dispenser Restore (CorobTECH)

Performing the Corob Restore Using CorobTECH Software

Open CorobTECH.

Enter “tech” for the CorobTECH password.

Under the Options menu, select Backup/Restore.

1

2
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Corob® Dispenser Restore (CorobTECH)

Select the Restore tab in the Backup/Restore window.

Then select the folder that contains the data to be restored. (In our example below,  
we are restoring from a flash drive.)

Choose Start to initiate the Restore.

3

4

When restoring is finished, you will receive a “Restore completed!” message.
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Corob® Dispenser Restore (CorobTECH)

Performing Restores for Your Important Corob Dispenser Files

(Alternate method of obtaining needed files.)

If you were unable to create the backup from the CorobTECH software, and you saved a copy of the local and GDATA 
directories from your original C: drive to a flash drive, then these directories can be restored manually.

The information contained in the collection of files includes your calibration and level information for your Corob dispenser.

You will need the flash drive with the two saved directories: local and GDATA.

These directories can then be copied into the root of the C: drive of your computer.

C:\local

C:\GDATA
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Corob® Dispenser Backup (EVOservice)

Open EVOservice.

Log into EVOService as the “Service Engineer.”

Under the File menu, select Backup/Restore.

In the Backup/Restore window, keep the default settings 
for the data to back up. 

Click the Save backup file... button, then select your 
destination folder.

Enter “tech” as the EVOservice password.

1 2

3 4
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Corob® Dispenser Backup (EVOservice)

When the backup is finished, you will receive a  
“Backup completed!” message.

Check that you can see the resultant backup file in the location  
where it was saved.

5 6
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Corob® Dispenser Restore (EVOservice)

Open EVOservice. 
Log into EVOService as the “Service Engineer.”

Enter “tech” as the EVOservice password.

1

3 4

2

Under the File menu, select Backup/Restore. Click on the Restore tab. 
Then click the Load backup file... button.
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Corob® Dispenser Restore (EVOservice)

Select the location of the backup file, then click Open. Click the Start restore button.

5 6

7

When restoring is finished, you will receive a “Restore completed!” message.  
Click the OK button, then exit out of the Backup/Restore window.
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Working with Half Pints 

Several accessories are available for shaking the half pint Color Samples,  
depending on the type of shaker you have in your store. 

Recommended Minimum Shake Times

2 minutes: All platform shakers.  

3-4 minutes: Shaker inserts.

Or follow the recommended shake times provided by the individual manufacturer.

Note: Platform shakers were shown to be more efficient at shaking half pints.

Please Note:

Order forms for dispenser stands and inserts for shakers can be found on our Retailer Gateway  
or you may order by contacting the vendor directly.

To access the order forms on the Benjamin Moore Retailer Gateway:

Sign on to the Benjamin Moore Retailer Gateway, 

Scroll all the way down to COLORx® and click Access Now.

Vendor Phone Email How to Order

Fluid Management  
Spare Parts Support

800-462-2466 (Ext 2) FUSORDEREntry@IDEXCORP.com
Email completed order form to 
FUSORDEREntry@IDEXCORP.com

Radia 800-221-1083 Orders@RadiaProducts.com
Orders@RadiaProducts.com (When ordering  
from Radia, have your Benjamin Moore dealer 
number ready for additional discount)

Hero 800-494-4376 CustomerCare@hero.ca 
Email completed order form to 
CustomerCare@hero.ca or call 800-494-4376

 Corob 704-588-8408 (Ext 3) Spareparts.NorthAmerica@Corob.com
Email completed order form to  
Spareparts.NorthAmerica@Corob.com or  
call 704-588-8408 (Ext 3)
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Working with Half Pints 

Choose (1) Ordering Tools, then (2) Approved Equipment.

Find your shaker/dispenser form from the options below.    

Choose SAVE to have the form saved to your Downloads directory.  

Use the proper corresponding form to order your equipment from the vendor.
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Half Pint Accessories for Corob® Dispensers and Shakers

Half Pint Tray for EVOshake 500:

	 • Part number A5995S					   

	 • Guaranteed to fit the Corob EVOshake 500

	 • Fits up to 16 half pint sample paint cans

	 • Size: 13.5" x 12.25" x 3" (34.3 x 31.1 x 7.6 cm) 

Quart/Pint/Half Pint Stand for Corob Dispensers:

	 • Part number 200153

	 • Fits all Corob dispensers

	 • Sized for quart, pint, and half pint containers

Quart/Pint/Half Pint Adapter for VORmix 1:

	 • Part Number 6783756

	 • Fits COROB VORmix 1 gallon vortex mixer

	 • Sized for Quart, Pint and Half Pint containers
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Half Pint Accessories for Fluid Management® Shakers 

1.	8 oz. Sample Tray for 5G Shaker

	 Part number 32044

2.	Quart Adapter & Foam Sleeve 

	 Adapter

	 Part number 25090

	 Foam Sleeve

	 Part number 39278



27

Half Pint Accessories for Radia® Shakers

Half Pint Tray for 5995 Agitar™

	 • Fits 4 to 16 half pint sample paint cans 

	 • Size 13.5" x 12.25" x 3"

	 Part number A5995S Half Pint Tray

Half Pint Foam Insert for Quart Adapters

	 • Fits 1 or 2 half pint sample paint cans

	 • Fits inside quart adapter

	 Part number 6786133 Half Pint Foam Sleeve
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Half Pint Accessories for Hero Mixers

Five-Gallon Multi-Mix Shaker S2700 Model

One-Gallon Vortex Mixer

S2700

S2450

Riser

Each S2700 vibrational shaker model includes a riser (see picture above) that elevates  
smaller cans, including half pints, to allow for secure clamping with the top clamping plate.  
Shaking times for half pints is the same as for pint and quart containers.
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Half Pint Accessories for Hero Mixers

QUART PINT HALF PINT

Each ‘S’ Series one-gallon vortex mixer includes the adapter pictured above.

Contact the vendor for current pricing and additional information.

Hero Half Pint Sampler Resale Accessories 

Quart/Pint/Half Pint Booster Seat (for A961 Dispenser)
Part Number AT60208 for Hero Model A961

Adapter Quart/Pint/Half Pint (for S2700 Shaker)
Part Number HL1101-1000
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Half Pint Accessories for Hero Mixers

Red Adapter Kit for Pints and Half Pints (2 Pieces) for All 24XX Series 
Part number HL350-A26

Adapter Assembly - Gray Standard Quart Adapter for All 24XX Series 
Part number HL350-A11

The above items are offered separately or as a set:
Gray Quart Adapter Kit and Red 2-Piece Pint and Half Pint Adapter Kit for All 24XX Series
Part number HL350-A27
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X-Rite® MetaVueTM Recommended Maintenance

The MetaVue is a breakthrough non-contact imaging spectrophotometer introducing  
a new level of accuracy to a wider variety of customer samples.

1a

1e

1d1c1b

1f

2a

2d

2c

2e

2b

1. Cleaning
•  �To clean, place the MetaVue (1a) on its back so that the lenses 

are facing you (1b).
•  �Push the measurement slider into a completely retracted (1c) 

position so that the lenses are now exposed (1d) and can be 
cleaned with optic lens wipes.

•  Clean all of the lenses (1e) and the calibration plaque (1f).

Use only optic lens wipes to clean your MetaVue. Do not use any 
all-purpose cleansers. Anytime you clean your device, you should 
calibrate it again before taking any measurement.

2. Calibrating
Calibration must be done once per day. The MetaVue displays a red light if the instrument needs to be calibrated. 
•  �To calibrate your device’s white point, first locate the slider on the bottom of the device. Make sure the slider is locked in place  

by fully pulling it upward toward yourself (2a). 
•  �The software will then prompt you to measure with a measurement button. If the measurement button is disabled, it means the white  

plaque is not positioned correctly (2b). A green checkmark will appear on the screen once your measurement is complete (2c).
•  �After calibrating the white plaque, you will be prompted to calibrate the targeting window. Locate the target window on the bottom  

of the device and slide it into the measurement position (2d). 
•  �The software will then prompt you to measure with a white measurement button. A green checkmark will appear on the screen  

once this measurement is complete (2e).
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1a

2a 2b

1b 1c

2c

1. Cleaning
The iVue’s optics are protected by lenses. The lenses and calibration plaque must remain clean.
•  Clean the four lenses (1a & 1b) and calibration plaque (1c) with supplied lens tissues and cotton swabs at least once per week.
•  After cleaning, always calibrate the iVue.
•  Use proper cleaning materials to ensure no residue is left on lenses or calibration plaque after cleaning. (See Ordering, page 33.)

2. Calibrating
Calibration must be done once per week but may be done more frequently.
Important: Do not calibrate to the white dot on black mat (2a) or to the white dot on 6 mm Small Sample Holder.
•  Ensure iVue lenses and calibration plaque are clean before calibrating. (See Cleaning, above.)
•  Slide calibration plaque forward (2b) on the rail beneath the targeting ring (2c) before calibrating.

The iVue is a precision instrument that provides excellent 
color matching results when properly maintained.

X-Rite® iVue Daily Recommended Maintenance
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X-Rite® Recommended Tips and Supplies

3a

3b 3b 3b

3a 3a

3. Measuring
The iVue has two aperture sizes indicated by large and small green target rings. Color matching accuracy will be improved by keeping  
the samples flat. The Spring Retainer and 6 mm Small Sample Holder are designed to flatten card stock so there are no curves or bends on  
the sample to measure.
Large Samples
•  �When the solid color sample is more than 1/2 inch, use the Spring Retainer (3a). Slide the Spring Retainer onto the instrument rail  

and place the sample under the Spring Retainer. The large green target ring must be used when measuring a large sample.
Small Samples
•  �When the solid color sample is less than 1/2 inch, use the 6 mm Small Sample Holder (3b). Place sample in the holder and verify  

the sample fills the entire hole. Slide the 6 mm Small Sample Holder onto the instrument rail. The small green target ring must be used 
when measuring with this holder.

4. Ordering
iVue Maintenance Kits
•  Black Mat 12-Pack: part number VS205-77-Kit
•  Cleaning Kit: part number VS205-81-Kit
•  Maintenance Kit: part number VS205-85-Kit 
To order, call 800-572-4626.

Do not measure 
bent samples. 
Samples must 
be flat.

Insert small 
sample into 
6 mm Small 
SampleHolder.

Black Mat 12-pack Part number VS205-77-Kit Cleaning Kit Part number VS205-81-Kit Maintenance Kit Part number VS205-85-Kit

Place sample under 
spring retainer.

Large Sample Method

Small Sample Method
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1a

2a 2b

1b 1c

2c

1. Cleaning
1a A clean white reference ceramic tile is essential for providing accuracy of your measurements.  1b The protection cover should always be closed when the white reference 
ceramic tile is not in use.  If necessary you can clean the white reference ceramic tile with isopropyl alcohol and a soft clean cloth
General Maintenance
1c Do not touch the diffuser disc of the ambient light limiting aperture.
Do not store or operate the i1Paint device in dirty, greasy or dusty environments.  Do not use the i1Paint in environments with with temps higher than 35° C (95°F) or less 
than 10°C (50°F).  The i1 Paint device is sensitive to mechanical shocks.  To avoid damage during transport, the i1 Paint must always be shipped in its original packaging.

2. Calibrating
In the center of the calibration plate is a slider to protect the white calibration tile.  2a Open this protective slider until it clicks into place to access the white tile on this 
calibration plate.  2b Place the i1 Paint measurement device on the calibration plate.  2c The device must sit firmly on the calibration plate.
Start the calibration mode in the software.  Once the device is successfully calibrated the status indicator light pulsates white.  If the calibration fails the status indicator light 
pulsates red and then returns to solid white.
When the calibration is finished you should close the protective slider for the white reference ceramic tile.

Note:  If you own multiple devices, make sure that the serial number on the front and back of the calibration plate matches the serial number of your i1 Paint device.

The i1Paint is a precision instrument that facilitates a one-hand 
operation with a portable lightweight design.  This instrument has 

no power supply and can read samples as small as 8mm. 

X-Rite i1Paint Daily Recommended Maintenance
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The i1Paint is a precision instrument that facilitates a one-hand 
operation with a portable lightweight design.  This instrument has 
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X-Rite i1Paint Daily Recommended Maintenance

The i1 Paint is a precision instrument that facilitates a one-hand
operation with a portable lightweight design. This instrument has

no power supply and can read samples as small as 8 mm.

X-Rite® i1 Paint Daily Recommended Maintenance

1. Cleaning
A clean white reference ceramic tile is essential for providing accuracy of your measurements (1a). The protective cover should always 
be closed when the white reference ceramic tile is not in use (1b). If necessary, you can clean the white reference ceramic tile with 
isopropyl alcohol and a soft clean cloth 
General Maintenance
Do not touch the diffuser disc of the ambient light limiting aperture (1c). Do not store or operate the i1Paint device in dirty, greasy, or 
dusty environments. Do not use the i1 Paint in environments with temps higher than 35°C (95°F) or less than 10°C (50°F). The i1 Paint 
device is sensitive to mechanical shocks. To avoid damage during transport, the i1 Paint must always be shipped in its original packaging.

2. Calibrating
• In the center of the calibration plate is a slider to protect the white calibration tile. Open this protective slider until it clicks into place to  
	 access the white tile on this calibration plate (2a). Place the i1 Paint measurement device on the calibration plate (2b). The device must  
	 sit firmly on the calibration plate (2c).
• Start the calibration mode in the software. Once the device is successfully calibrated, the status indicator light pulsates white. If the  
	 calibration fails, the status indicator light pulsates red and then returns to solid white.
• When the calibration is finished, you should close the protective slider for the white reference ceramic tile.

Note: If you own multiple devices, make sure the serial number on the front and back of the calibration plate matches the serial 
number of your i1 Paint device.
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BYK auto-match IV  
Recommended Monthly Maintenance

1 2 3

1. Keeping the BYK auto-match IV clean

When not in use keep the paddles in place in front 
of the measurement port.  This protects the 
calibration standards as well as limits the amount of 
airborne particles entering the measurement port, 
which can affect accuracy.

During measurement the grey tile closest to the 
measurement port may be used as a sample clamp.  
Do not use the other paddles in this way as it may 
lead to dirty standards and inaccurate calibration.

If the calibration tiles become dirty they may be 
cleaned using isopropyl alcohol and a lint free cloth.  
If the auto-match fails calibration or produces 
inaccurate results, try cleaning the standards and 
calibrating again.

2. Calibrating the instrument

Calibration is performed using the paddles 
attached to the front of the instrument.

First:  Pull back the sample holder and slide the 
two attached discs to the right.  Gently return the 
plunger back into position and initiate the reading 
of the ‘black trap’.

The picture above shows the black trap which is 
found furthest from the measurement port.

3. White calibration tile in place

 Second: Pull back the sample holder once again 
and slide the middle disc back into position and 
then initiate the reading of the ‘white tile’. 

The white calibration standard is in the middle 
of the three paddles. 

The third paddle, closest to the measurement 
port, is a grey tile and is there for protective 
purposes only.  This tile is not utilized in the 
calibration process.  

Preventive Maintenance or Repairs
For preventative maintenance or repairs contact 
BYK-Gardner's service department at 800-343-7721 
option 2.

The BYK auto-match IV spectrophotometer can color match in all existing Benjamin 
Moore® products. Small and compact, standards are integrated into the sample clamp.  

This unit provides temperature stable results without constant calibration. Comes with a 
three (3) year guarantee on the instrument, ten (10 ) year on the light source.
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BYK auto-match IV  
Recommended Monthly Maintenance

1 2 3

1. Keeping the BYK auto-match IV clean

When not in use keep the paddles in place in front 
of the measurement port.  This protects the 
calibration standards as well as limits the amount of 
airborne particles entering the measurement port, 
which can affect accuracy.

During measurement the grey tile closest to the 
measurement port may be used as a sample clamp.  
Do not use the other paddles in this way as it may 
lead to dirty standards and inaccurate calibration.

If the calibration tiles become dirty they may be 
cleaned using isopropyl alcohol and a lint free cloth.  
If the auto-match fails calibration or produces 
inaccurate results, try cleaning the standards and 
calibrating again.

2. Calibrating the instrument

Calibration is performed using the paddles 
attached to the front of the instrument.

First:  Pull back the sample holder and slide the 
two attached discs to the right.  Gently return the 
plunger back into position and initiate the reading 
of the ‘black trap’.

The picture above shows the black trap which is 
found furthest from the measurement port.

3. White calibration tile in place

 Second: Pull back the sample holder once again 
and slide the middle disc back into position and 
then initiate the reading of the ‘white tile’. 

The white calibration standard is in the middle 
of the three paddles. 

The third paddle, closest to the measurement 
port, is a grey tile and is there for protective 
purposes only.  This tile is not utilized in the 
calibration process.  

Preventive Maintenance or Repairs
For preventative maintenance or repairs contact 
BYK-Gardner's service department at 800-343-7721 
option 2.

The BYK auto-match IV spectrophotometer can color match in all existing Benjamin 
Moore® products. Small and compact, standards are integrated into the sample clamp.  

This unit provides temperature stable results without constant calibration. Comes with a 
three (3) year guarantee on the instrument, ten (10 ) year on the light source.

The BYK Auto-Match® IV spectrophotometer can color match in all existing  
Benjamin Moore® products. Small and compact, standards are integrated  

into the sample clamp. This unit provides temperature-stable results  
without constant calibration. It comes with a 3-year guarantee on  

the instrument and a 10-year guarantee on the light source.

BYK® Auto-Match IV
Recommended Monthly Maintenance

1. Keeping the BYK  
	 Auto-Match IV Clean

When not in use, keep the paddles  
in place in front of the measurement 
port. This protects the calibration 
standards as well as limits the 
amount of airborne particles 
entering the measurement port, 
which can affect accuracy.

During measurement, the gray tile 
closest to the measurement port 
may be used as a sample clamp.  
Do not use the other paddles in  
this way as it may lead to dirty 
standards and inaccurate 
calibration.

If the calibration tiles become 
dirty, they may be cleaned using 
isopropyl alcohol and a lint-free 
cloth. If the Auto-Match fails 
calibration or produces inaccurate 
results, try cleaning the standards 
and calibrating again.

2. Calibrating the Instrument

Calibration is performed using the paddles 
attached to the front of the instrument.

Pull back the sample holder and slide the 
two attached discs to the right. Gently 
return the plunger back into position and 
initiate the reading of the “black trap.”

The picture above shows the black 
trap, which is found farthest from the 
measurement port.

3. White Calibration Tile in Place

Second: Pull back the sample holder once 
again and slide the middle disc back into 
position and then initiate the reading of the 
“white tile.”

The white calibration standard is in the 
middle of the three paddles.

The third paddle, closest to the measurement 
port, is a gray tile and is there for protective 
purposes only. This tile is not utilized in the 
calibration process.

Preventive Maintenance or Repairs  
For preventive maintenance or repairs,  
contact BYK-Gardner’s service department 
at 800-343-7721 option 2.
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Datacolor® 45G  
Recommended Monthly Maintenance

1 2 3

1. �Cleaning the Sphere
Do not allow anything to fall into the 
measuring port opening. When the 
instrument is not in use, store it in the  
case or facedown on a flat surface to  
avoid any dust buildup. Never allow liquids 
to enter the measuring port opening.

Never wipe the inside of the measuring  
port opening with anything. If there is 
a dust buildup, you could try to vacuum 
the dust out by holding a vacuum in front  
of the measuring port opening.

Never measure wet samples. If needed,  
you can promptly use a damp cloth to 
wipe down the outside of the unit if 
anything gets on it. If there is a dust  
buildup on the outside, you could wipe  
with a damp cloth as well.

2. �Handling the Tiles  
Make sure to keep your tiles in the case 
that comes with the instrument. Handle 
calibration tiles with extreme care. Do not 
drop them or scratch the glazed surface. 
Always grasp the tile using its edges.

3. �Cleaning the Tiles
Wipe each tile clean with a soft, lint-free 
cloth before each use. In the event your 
tiles come into contact with inks, paints,  
or other coatings, you may use a soft  
cloth moistened with isopropyl alcohol  
to clean off the residue.
 

4. �Cleaning the Black Trap 
The black trap should be kept dust-free.
To keep the black trap dust-free when  
it is placed on the countertop, keep the 
opened end facing down. 

Dust accumulating in the black trap 
should be blown out with moisture-free 
compressed air.

5. �Calibrating the Instrument
Once the unit is untethered, it needs to 
be calibrated. The calibration includes the 
utilization of the black trap, along with the 
white calibration and black gloss tiles. 
 

The Datacolor® 45G is a 0/45 spectrophotometer that can color match in all  
existing Benjamin Moore® products. This instrument is also portable and can be  
used to perform remote measurements and then download them to COLORx.
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Where to Start?
Begin with an existing Benjamin Moore color that is visually close to the color you are trying  
to match. Reduce the formula by at least 20% while also holding out the white and black.

Best Practices
1. Practice on mistints (with store permission).

2. Listen to and learn from the best color matcher(s) in your store.

3. Learn the various strengths of colorants.

4. �Understand that there are no set quantities of “how much to add.”

5. Understand how complex colors are affected by their environment, substrate, and lighting.

Helpful Hints
•  Always do your best to adjust the color using the original COLORx® formula.

•  Avoid opposite colorants when adjusting a color. 

•  Have a color wheel on hand and know how to use it.

•  �Adding white does not lighten a color significantly (especially in light colors),  
and if you use too much in a dark color, it will make the color milky.

•  �Adding black will make a color muddy (toning) and muted.

•  �REMEMBER to use baby steps when adding colorant! If you put too much in,  
you generally cannot bring the color back.

•  �When doing a custom match, always brush out and dry a sample each time  
you add colorant (never try to match a wet sample to a dry sample).

•  �Always use the appropriate tinting base and do not overfill, as the can must have  
at least two ounces worth of air space to allow the colorant to disperse properly.

•  �Daylight is the best light for viewing color matches.

The following is for the person new to color matching.  
Please use with guidance from an experienced color matcher.

Introduction to Color Matching
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Evaluating Dispenser Accuracy

Fifty percent of all mistints are not caused by the color formula.
This test will help you to determine if the mistint is related to your

dispensing equipment, an employee error, or the color formula.

1. Verify you have the latest version of COLORx® on your dispenser computer. (To download,

	 sign on to the Benjamin Moore Retailer Gateway, scroll down to COLORx and choose Access Now, 

	 then choose Download.)

2. Perform daily maintenance.

3. Follow the three-step process indicated below:

		  • Step 1: Identify which colorant is causing the mistint.

		  • Step 2: Use recommended base product.

		  • Step 3: Use the following colors (*COLORx version 6.38.1000 or higher).

4. Shake the can for 6 minutes.

5. Dry the color on a white unlined note card.

6. Retrieve selected color chip from chip rack (chips dated 5/2015 or newer).

7. Visually compare your color to the chip using natural light. If the colors do not match,  
your dispenser is overshooting or undershooting a certain colorant(s).

8. If the colors do not match, contact your dispenser company to have service performed.

9. If the colors match, it may be a color formula problem. Follow the Color Complaint Process;  
contact your Benjamin Moore representative for guidance.

Step 1 Step 2 Step 3

Dispensing Issue Use Product Use Color*

Too little or too much B1 200 767

Too little or too much G1 200 767

Too little or too much M1 200 1347

Too little or too much O1 200 2014-40

Too little or too much R1 200 983

Too little or too much R2 200 1347

Too little or too much R3 200 2097-30, OC-16

Too little or too much S1 200 OC-16, 2097-30, 983

Too little or too much S2 200 767

Too little or too much W1 200 2097-30

Too little or too much Y1 W105 Qt. or N401 Qt. 2029-40

Too little or too much Y2 200 2014-40

Too little or too much Y3 200 OC-16, 983
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Shake Times
To ensure proper color development, paint shaking is an important process.  

Shake times, for example, are dependent not only on the colorant and base but also  
on the shaker itself. The following chart represents shake times for various vendors:

AGITATEPOUR

OPENSITSHAKE

1 2 3

4 5

ALLOW 5 MINUTES
TO SHAKE IN MIXER

LET COLORANT SIT
IDLE FOR 5 MINUTES

OPEN COLORANT 
AND CHECK FOR  
IRREGULARITIES

POUR COLORANT
INTO CANISTER

AGITATE COLORANT  
FOR 3 MINUTES

RADIA® (RED DEVIL®)
Classic (Cradle Model) 1025 Red D (Vortex Model) Speed Demon 1 (Gyro Model) 5025 Roller Load (Gyro Model)

5 minutes 4 minutes 6 minutes 6 minutes

These guidelines are based on 
extensive testing completed by 
Benjamin Moore, incorporating 
multiple equipment vendors using 
both interior and exterior products.

ULTRABLEND
TruMix 1 (Gyro Model) TruMix 1 by Hero (Gyro Model)

5 minutes 4 minutes

HERO
S2850M Fusion Manual Clamp 5 Gal. S2450 1 Gal. Multi-Mix Countertop S2700 5 Gal. Mega-Mix Platform

6 minutes 4 minutes 4 minutes

FLUID MANAGEMENT
Harbil 5G (Platform case) VR1 (Vortex Model)

4 minutes 4 minutes

Gennex® Waterborne Color Technology

Colorant Preparation for Canister
Optimizing colorant performance, in canister, is also essential to  

maximizing the performance of your Gennex® colorant system. Use the  
following steps to properly prepare the colorant before filling:
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If you have a tinting-related issue that you cannot troubleshoot, 
contact customer support as follows.

Customer Support Contacts

Issue Model Contact Phone

Dispenser machine  
not operating properly

Fluid Management® (all) Fluid Management 1-800-462-2466

Corob (all) Corob 1-800-728-8408 x52

Hero (all) Hero 1-800-494-4376

Spectrophotometer  
not operating properly

MatchRite CF57U

MatchRite iVue

MatchRite i1 Paint

MetaVue

Datacolor® 45G

BYK Auto-Match IV

X-Rite 1-800-572-4626

Benjamin Moore 1-800-809-9213

Datacolor 1-800-982-6496

BYK 1-800-343-7721

COLORx® software not 
operating properly Benjamin Moore 1-800-809-9213

Benjamin Moore®  
color issues Benjamin Moore 1-800-809-9213

Seiko Smart Label not 
printing correctly

Seiko Smart Label 
Printer 650 Seiko 1-800-757-1011

Dymo® label writer  
not printing correctly Dymo 330, 400, 450 Benjamin Moore 

Color Technology 1-800-809-9213

Dymo label writer  
not printing correctly Dymo 330, 400, 450 Dymo Sanford 1-877-724-8324

Customer Support
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